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About O&O UnErase 4

 Simple Restoration of Deleted Files

These days the mistaken deletion of fi les is by far the most common cause of data loss. 
Making mistakes is human and often quite unavoidable. In the event that the unthinkable 
occurs, advice can be very expensive. Windows tries to avoid this problem with the Recycle 
Bin function – a sort of “Clipboard” for deleted fi les. When the Recycle Bin is emptied these 
fi les disappear leaving the user with the assumption that these fi les are now forever lost. But 
what happens when the Recycle Bin is emptied and with it a few precious fi les were deleted? 
Is there still hope to recover those deleted fi les and/or folders?

With the Explorer-style fi le structure from O&O UnErase you can navigate through your 
deleted fi les just as if they had never been deleted. With one click of the mouse you can 
restore single fi les or entire folders. Never before was the restoration of deleted fi les so easy 
and intuitive to operate. Whether it be those accidentally deleted text documents or those 
great photos from your last vacation, O&O UnErase can restore all data stored on drives 
recognized and monitored by Windows. With the detailed search function you are able to 
tailor your search to a specifi c set of parameters that can increase the speed and precision 
of your results. And with the completely overhauled algorithm for the restoration of data, 
now even more deleted fi les on your system can be found.

When you realize data has been deleted, stop all activity on the computer and immedi-
ately start O&O UnErase to restore the missing data. Sometimes, when too much time has 
elapsed since deletion, deleted fi les can be overwritten when other data are saved to the 
disk. This can hinder any chance of a successful restoration. This is why O&O UnErase should 
be installed long before any data loss occurs to allow for the quick and easy response to 
any problem.

We hope you enjoy using our product and hope that it will save you time and energy both 
at work and at home.

Your O&O Software
www.oo-software.com

 Note on Licensing

You can try out O&O UnErase 4 free of charge and obligation. The test version of the soft-
ware allows you to search for deleted fi les but does not allow their restoration. Only in the 
full version is the restoration of deleted fi les possible

O&O UnErase is licensed per computer. This means that a single license is required for every 
computer on which O&O UnErase is installed. One license cannot be transferred to an add-
itional computer. If you would like to use O&O UnErase in your company or as a technician 
for your customers, please contact either one of our authorized dealers or our sales team 
for special licensing options.
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 Technical Limitations of Data Restoration Software

O&O UnErase is software designed to restore deleted data. Please note, however, that it 
may not be possible to restore all deleted data if the areas where the deleted data is stored 
(including the directory table) has already been overwritten by new data.  When this occurs, 
the restoration of data with O&O UnErase is not possible. Please do not delete any data for 
fun or for test purposes without fi rst making a backup copy. We strongly recommend that 
you regularly make backup copies of your important data and store them in a safe place.

 What should I do when data accidentally gets deleted?

When data are mistakenly deleted on you computer it is very important to do the following 
to maximize your chances of a successful data restoration. Should you have further ques-
tions, you can always contact our technical support department. Please note that we can 
only provide this support for registered users of the software according to their individual 
license agreements. However, in conjunction with our subsidiary O&O Services GmbH, our 
support staff would be more than happy to offer you fee-based assistance in rescuing your 
lost data.

The correct behavior when faced with the loss of important data can contribute greatly to 
your chances of a successful data restoration. It is important to understand that when data 
are deleted, they are simply reclassifi ed on the hard disk or memory card as “free”. This all-
ows the computer to overwrite and therefore destroy those deleted data. Once a piece of 
data has been overwritten, it is no longer restorable through basic data rescue methods.

 How to Increase the Chances  of a Successful Restoration of Data?

• If possible, do not save any more data onto the system after the data in question have 
 been deleted.
• Close all applications without saving any data to the disk or other data storage media (if 
 possible).
• Shut down the computer.
• Think calmly about how the data were deleted. Try not to panic and quickly restore the 
 data in question. Reckless behavior can lead to even more data loss.
• If the data was deleted “normally”, they can be found in the Recycle Bin. Open the Re-
 cycle Bin and restore the fi les.
• If the data were really deleted then it is advised to use O&O UnErase to restore them. 
 Load and install the software onto another partition of the hard disk (e.g. “D:\” instead 
 of “C:\”). In other words, on a section of the hard drive where the data in question are 
 NOT stored.
• If you only have one partition (such as “C:\”) it is advised that you download and install 
 the software onto another computer. Then create an emergency disk with “O&O Instant-
 UnErase” on it. More details regarding this function can be found in the section entitled 
 “Starting O&O UnErase Without Installing It”.

Important Information on Restoring Data
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 If the data has been already deleted

1. Install O&O UnErase onto a different computer than the one on which you would like to 
 restore the data in question.
2. Create an emergency disk complete with the O&O InstantUnErase Assistant.
3. Start O&O InstantUnErase on the computer on which the data in question were de-
 leted.
4. Follow the directions as described in the section entitled “Using O&O UnErase in Case 
 of Emergency”.

 Preparing O&O UnErase in Case of Emergency

1. Install O&O UnErase onto the computer on which you would like to restore data should 
 an emergency arise.
2. Register O&O UnErase with the purchased license code. Without a valid license code it 
 will not be possible to restore data with the software.
3. All necessary preparations are now complete. If an emergency does indeed occur, you 
 now have a better chance of restoring lost data. To do so, please follow the instructions 
 described in the section entitled “Using O&O UnErase in Case of Emergency”.

 Using O&O UnErase in Case of Emergency

1. Start O&O UnErase from the Start Menu. By default a shortcut to the software will be 
 installed in its own folder O&O UnErase in the program group O&O Software. Click on 
 O&O UnErase to open the program.
2. After O&O UnErase has been started, select the drive on which you would like to rescue 
 your data. In the main view, click on the drive to select it.
3. From the File menu select the command Search for deleted fi les.
4. If the deleted fi le could be found, it will appear in the fi le list to the right and be marked 
 with a red “x”.
5. Select the fi le and select the option Restore from the File menu.
6. Select a target directory that is not on the same drive.
7. As soon as the restoration of the fi le is completed, the fi le can be found in the target 
 directory and opened.

Getting Started
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 System Requirements

 Note:
 The Info rmation contained in this chapter will not be relevant to you if you are using 
 O&O UnErase as part of the O&O RescueBox or O&O BlueCon. This version can be run 
 directly from the CD on computers lacking operating systems. More information may be 
 found in the O&O RescueBox/O&O BlueCon User's Guide of at www.oo-software.com

O&O UnErase 4 is compatible with the following: 
• Windows Vista
• Windows XP 
• Windows 2003 Server 
• Windows 2000 
• Windows NT 4 (all versions with at least Service Pack 6 and Microsoft Internet Explorer 
 Version 5.01 and above installed)

Required Privileges
In order to install and register O&O UnErase, you must be a member of the local group 
administrators or possess equivalent permissions. If you are a domain administrator, you 
should have the permissions required as well.

 Installation of O&O UnErase 4

The installation of O&O UnErase is very simple. Please follow the steps below:
1. Start the computer on which you wish to install O&O UnErase.
2. Sign in as a local administrator.
3. Open O&O UnErase's installation fi le that you either downloaded from our web server 
 or have stored on the software's CD-ROM.
4. After the setup program has been successfully initialized, please follow the on-screen 
 dialog to complete the installation process.
5. During the installation process you will be able to select who is granted access to 
 O&O UnErase; only the current user or all users.

 Updating to O&O UnErase 4

Updating from the old version of O&O UnErase to the newest 4 is simple and fast.

Microsoft Software Installer 2.0 or higher
1. Start the setup program for the update.
2. A dialog box will appear in which you will be given the choice to Change, Repair, or Re-
 move the program.
3. Select Repair and click on Next.
4. The new version of O&O UnErase will then be installed. All previous settings will be ca-
 rried over into the new version. 

Installation and System Requirements



Microsoft Software Installer 1.0
1. Open the Control Panel by going to the Start Menu heading Settings.
2. Click on Add/Remove Programs.
3. Select O&O UnErase from the list of installed software.
4. Click on Add/Remove.
5. The deinstallation of O&O UnErase will be initialized.
6. A dialog box will appear in which you will be given the choice to Change, Repair, or Re-
 move the program..
7. Select Remove and click on Next (the option to Repair a program is not available in the 
 older version of MSI).
8. The older version will be removed. It is, however, possible to keep the old settings from 
 the previous version and use them for the new version.
9. After the deinstallation is complete it will now be possible to install the new release. To 
 do so, just follow the directions that are described above regarding the normal installa-
 tion of O&O UnErase 4.

 Entering the License Code

After installation has been completed, the O&O Registration will be started, making the 
registration of O&O UnErase simple and effi cient. To register O&O UnErase you will need 
to use the registration code you received when you purchased your product. 

This registration code is also referred to as the license key, license code, serial number, or 
product ID. It may consist of either just a serial number or a combination of the names and 
serial numbers. Please note the directions that accompanied your license code.

The registration code can be entered during installation or later at your convenience. To do 
so, simply open the unregistered version of O&O UnErase and the Registration Assistant 
will appear.

Installation and System Requirements l 5User's Guide for O&O UnErase 4
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Registration Assistant

Unregistered Test Version
The Registration Assistant will appear every time the unregistered version of O&O UnErase 
is opened. It will also appear when the registration code has been incorrectly entered. 
Should this occur, please double-check your registration code and try again.

The fi rst step is to select whether you would like to enter your purchased registration code, 
continue to use the unregistered test version of O&O UnErase, or purchase your own li-
cense. When you have made your decision, please press the Next button to continue.

Select Enter registrations code to proceed to step 2 of the registration assistant.

If you decide to continue testing the product, the program will start. If you click on Buy now, 
you will be forwarded to our homepage where you can fi nd information about the purchase 
of our products.

The registration of O&O UnErase may be aborted at any time. To do so, simply click on the 
Cancel button and confi rm your decision.



Registration Dialog
In the registration dialog you can enter your registration code that you received when you 
purchased O&O UnErase. 

Please enter your name, your company's name, and then your serial number. Please note 
that this number must match the number you received through the purchase of the product. 
In addition, make sure that your do not confuse the letter “O” with the number “zero” or 
enter in any empty spaces.

Then click on Next to save the registration data or Cancel to close the dialog box without 
saving any registration information.

Registration Dialog

If you run into any problems during registration, please contact our support department.

Completing Registration
If the license code was correctly entered, a dialog box will appear confi rming this. It will now 
be possible to immediately register online and take advantage of the services O&O has to 
offer. This includes technical support and discounted software updates.

To do so, click on Register product online, to close the Registration Assistant, click on 
Close.

Installation and System Requirements l 7User's Guide for O&O UnErase 4
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 Removing O&O UnErase

To remove O&O UnErase from your System, open the Control Panel under the heading 
Settings in the Start Menu and click on Software. 

Please select O&O UnErase 4 from the list of installed software and click on the Add/Re-
move button. 

Confi rm the deinstallation of O&O UnErase 4. After this process is completed, a dialog box 
will appear confi rming this. O&O UnErase is now removed from your system.
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 Starting O&O UnErase

As part of the installation process, a program group will be created in the Start Menu for 
O&O UnErase. This program group may be visible to all users or only the current user, de-
pending on which option was selected during O&O UnErase's installation. When it is visible, 
it may be found under the heading O&O Software.

In this program group you can fi nd the program O&O UnErase as well as a link to the online 
product documentation.

The online product documentation is your central source of information for all matters re-
garding the operation of O&O UnErase. As described above, this can be accessed through 
the O&O UnErase program group. Alternatively, this documentation can be accessed 
through the Help menu or by pressing F1 on your keyboard whenever the product is run-
ning.

 Main View

The Main View in O&O UnErase behaves similarly to Windows Explorer, enabling you to 
easily use the program with only little or no previous knowledge.
The Main View is divided into three vertically tiled panes:
• Frequently used commands and settings are accessible through the pane on the left. 
 These commands are also accessible through the Toolbar or the Context Menu.
• The List of drives and directories in the middle pane enables an easy navigation through 
 existing and already-deleted fi les very similar to Windows Explorer.
• The List of Folders and Files on the right-hand side gives you all pertinent fi le information 
 regarding the selected existing and deleted fi les.

 Using O&O UnErase

User's Guide for O&O UnErase 4



10 l Using O&O UnErase User's Guide for O&O UnErase 4

Main View of O&O UnErase 4

 Status Bar
At the very bottom of the Main View the Status Bar can be found in which the progress of all 
running searches and other status reports are displayed.

 Toolbar
The Toolbar is the fastest way to access the most important functions of O&O UnErase. All 
commands, however, can be accessed through the pull-down menus at the top of the Main 
View. Through the View menu you can customize the composition of the Toolbar to meet 
your needs.

Toolbars including the Quick Search Bar



Displayed from left to right:
• Search for a drive on the system.
• Open the Advanced Search dialog.
• Restore deleted fi les.
• Cancel current search.
• Go up one level.
• View Help.
• View program information.
• Switch views.
 • Tiles
 • Icons
 • List
 • Details
 • Toggle task list.
 • Displays only deleted fi les and folders.
 • Toggle Filter function.

 Quick Search
The Quick Search Bar below the Toolbar enables the simple and immediate search of folders 
on a particular drive by allowing you to enter a specifi c directory path. It is also possible here 
to use place holders such as '*'.

Quick Search Bar

 Filter
If you would like to limit the fi les displayed in the fi le list on the right-hand side, it is pos-
sible to use the Filter function. This feature may be activated through the View menu or by 
pressing the Filter icon in the Toolbar. When activated, a series of fi elds will appear in which 
specifi c text may be entered to narrow down the number of fi les displayed. As before, it is 
possible here to use place holders.

List with Activated Filter Function

Using O&O UnErase l 11User's Guide for O&O UnErase 4
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 Tip:
 In general, it is easier and faster to just use the Advanced Search function to fi nd and 
 display a specifi c set of fi les.

 Searching for Deleted Files and Folders

To fi nd deleted fi les and folders on a drive, please follow the directions below:
1. Select from the list of drives on the system the drive which you would like to search.
2. From the File menu at the top of the screen select the command Search for deleted 
 fi les.
3. The search will now be initialized. You can follow the progress of the running search in 
 the Status Bar at the bottom of the screen.
4. After the search is completed, the fi les and folders found during the search will be 
 marked in both the list of drives and fi les with a red “X” or arrow.

Main View with Deleted Files and Folders



 Tip:
 You can also execute a Quick Search by way of the Search fi eld in the Toolbar. Just enter 
 the drive letter and the path of the directory you would like to search and press Enter on 
 your keyboard.

 Cancelling a Search

If you would like to cancel a Search, select Cancel search from the File menu or press the 
corresponding icon in the Toolbar. The search will then be canceled and the fi les and folders 
that have already been found will be displayed.

'Cancel Search' Icon in the Toolbar during a Search

 Tip:
 Alternatively you can use the keyboard shortcut Ctrl+Esc to interrupt a running search.

 Deleted Files and Folder Designations

The red “X” indicates a fi le or folder is deleted. A small “X” displayed with a folder indicates 
that deleted fi les have been found in this folder, although the folder itself is still intact.

Normally the original fi le names of the deleted fi les can be restored. However, if this is not 
possible, the folders and fi les will be generically numbered and named by O&O UnErase.

Using O&O UnErase l 13User's Guide for O&O UnErase 4

Icon Defi nition

The folder has been completely deleted (large red “X”)

The folder contains deleted fi les or folders (small red “X”)

This fi le has been deleted and can probably be restored (red arrow).
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 Restoring Files and Folders

The next step after deleted fi les or folders have been found is to restore the ones you need 
(if this is possible).

 Tip:
 Please note that in the middle pane of the Main View only one single folder may be se-
 lected for restoration. In the right-hand pane it is possible to select more than one fi le for 
 restoration by pressing the Ctrl key on the keyboard while selecting multiple fi les. To 
 select all fi les in a specifi c older, use the keyboard shortcut Ctrl+A. 

1. Files and/or folders you wish to restore can be selected in either the middle or right-
 hand panes of the Main View.
2. Press the Restore icon on the Toolbar or select the corresponding heading in the Con-
 text Menu. 
3. It is now possible to select where the restored fi les are to be saved. As your target direc-
 tory, you may create a new folder or select one that already exists.
4. In order to avoid any possibility of data loss, it is advised that you save the newly re-
 stored fi les onto a different partition than the one where the fi les were originally stored. 
 Please be aware that it is possible to store the fi les onto a network drive as well.

 Tip:
 It is also possible to simply drag-and-drop deleted fi les and folders you would like to 
 restore into a directory displayed in the Main View. The restoration of the deleted fi les 
 will automatically follow.

Selection of Target Directory



 Advanced Searches

With the O&O UnErase's Advanced Search function, you possess a powerful tool for quickly 
and securely fi nding deleted fi les. Through a series of user-defi ned search parameters it is 
possible to considerably increase the precision of your search result.

Advanced Search Dialog 

 Search Settings
The search settings dialog enables you to defi ne the drive or folder to be searched. If you 
would like to also search subfolders, select the option with the same name.

It is also a possibility to expand the search to include fi les that have not been deleted. To do 
so, please uncheck the option Only search for deleted fi les. If this option remains selected, 
only deleted fi les will appear in the search results.

Filename
In the fi eld called Filename, you can either enter an exact fi lename or a fi lename containing 
a placeholder. For example, “*.BMP” would indicate you only wanted to search for Bitmap 
images. 

Using O&O UnErase l 15User's Guide for O&O UnErase 4
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Letter capitalizations are not considered by the search function. You can use the special 
characters “*” and “?”. “*”, however, can be used for multiple characters, whereas “?” may 
only stand for a single character.

Contained Text
An especially powerful option is searching for text contained in the fi le. If you are looking 
for a fi le but only can remember a fragment of its name or contents, then this could be very 
useful to you.

 Using the Filter When Searching
In order to customize your search further, it is possible to use the Filter function.

File Size
Here you can limit the size of the fi les that are to be searched. Just enter a range in Kbytes 
in which the desired fi le might fi t.

Date
This option allows you to enter a range of dates pertaining to the fi le and defi ne how that 
date range is to be applied during the search:
• Created – Date when the fi le was fi rst created
• Modifi ed – Date when the fi le was last saved
• Accessed – Date when the fi le was last accessed

File Name Meaning

* All fi lenames

*.* All fi lenames containing a “.” e.g. a.txt, abc.doc, xyz.exe

A* All fi lenames that begin with “a” or “A”

*a All fi lenames ending with an “a” or “A”

*a* All fi lenames containing an “a” e.g. abc.txt, cba.txt

*.txt All fi lenames with “.txt” on the end

?.txt All fi lenames consisting of a single character and “.txt” e.g.  
a.txt, 9.txt

A?c.txt All fi lenames that contain an “a”, followed by a single charac-
ter, and ended with “c.txt”



File Attributes
The search can also be narrowed down to look for specifi c attributes of the desired fi le. You 
can select from three options regarding each specifi c attribute:
• Marked (Checked) – The fi le must exhibit this attribute.
• Unmarked (Empty) – The fi le may not exhibit this attribute.
• Marked Green – This attribute will not be considered as a search parameter.

 Running an Advanced Search
To Run an Advanced Search you have three options:
• New Search – A search will be initialized and all previous search results will be lost.
• Add – The search will be initialized and the search results will be added to the search 
 results already displayed.
• Remove – The search will be initialized and those search results found will be fi ltered out 
 of the list of search results already displayed.

You may repeat the search function as many times as you like, adding or removing the 
results from the displayed list of search results as you go. While the search is running, the 
search dialog box will remain closed.

When you no longer wish to run a search, you can close the search dialog by pressing the 
Close button.
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 O&O InstantUnErase

 Note:
 The Information contained in this chapter will not be relevant to you if you are using 
 O&O UnErase as part of the O&O RescueBox or O&O BlueCon. This version can be run 
 directly from the CD on computers lacking operating systems. More information may be 
 found in the O&O RescueBox/O&O BlueCon User's Guide of at www.oo-software.com

If you would like to restore deleted fi les, it is imperative that you do not write any more data 
to disk. This is because only those fi les whose data have not already been overwritten by 
other data, can be restored. For this reason it is very important that O&O UnErase be al-
ready installed before a crisis occurs. The installation of the software after a data loss occurs 
could lead to the overwriting of the data you are trying to restore.

However, if a crisis occurs and O&O UnErase is not yet installed, there is another option. 
With the feature O&O InstantUnErase you have the possibility of running O&O UnErase 
without installation by creating an O&O InstantUnErase emergency disk on a parallel sys-
tem. 

 License to Use O&O InstantUnErase

In purchasing the license for O&O UnErase, you also purchased a license to for O&O Instant-
UnErase. O&O InstantUnErase is basically an “Emergency” version of O&O UnErase that 
can be used on both the computer where O&O UnErase is installed as well as an additional 
computer where the software is not installed. 

Because a single license may only be used on one computer, you will be required to do the 
following:
1. Install O&O UnErase on any computer. Do not enter the license code to unlock the full 
 version of the software. Instead, use the test version.
2. Start the O&O InstantUnErase Assistant from the Start Menu. Follow the on-screen di-
 rections to create an emergency disk.
3. Open O&O UnErase from the emergency disk on the computer on which you would like 
 to restore one or more deleted fi le(s). 
4. Enter the license code for O&O UnErase. This license now exclusively belongs to this 
 computer!

One the data restoration has completed, you now can install the full version of 
O&O UnErase onto this computer. Please note that using this software on multiple compu-
ter is not allowed and is against the license agreement. If you would like to use O&O Un-
Erase on multiple computers, it is possible to purchase a multi-user license. Our sales team 
would be more than happy to assist with this free of charge and obligation.

 Start O&O UnErase without Installation



 Creating an Emergency Disk

To create an O&O InstantUnErase Diskette, go to the corresponding heading in the Start 
Menu open the O&O InstantUnErase Assistant. Then follow the on-screen directions of 
the Assistant.

InstantUnErase Assistant

Next, you will be required to select where you would like to save this fi le. This can be a folder 
or drive (locally stored on your computer or on the network). Click the button Browse to 
select a location.
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Selection of Target Drive or Folder

Now select the fi le source. Here you have the possibility of selecting the O&O UnErase's 
installation folder or the actual installation fi le itself O&O Unerase.msi.
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Selection of File Source

Double-check your selections; insert blank media into the corresponding drive; then 
initialize the coping process. As soon as all fi les have been copied, you can start using 
O&O InstantUnErase.
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Copying Files to Removable Media

 Tip:
 The target folder can be a network drive or a USB stick as long as the computer on which 
 you would like to use O&O InstantUnErase can access that data.

 Starting and Using O&O InstantUnErase

Insert the created removable media into the drive of the computer on which you would 
like to run O&O InstantUnErase (or open the folder where the Assistant stored the O&O 
InstantUnErase data). Inside you will fi nd the fi le OOUE.EXE. Double-click this application 
to run it. An O&O UnErase registration dialog will appear. Enter your registration informa-
tion and continue.

Please note that the license will not be saved onto this computer. This could overwrite im-
portant data, potentially preventing their restoration. Because of this, the license will have 
to be re-entered with every new start of the program.

After a successful registration the Main View of O&O UnErase will appear. It will now be 
possible to use all of the features O&O UnErase has to offer. More information regarding 
this can be found in the section entitled “Using O&O UnErase”.
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 Technical Support

To receive more information about O&O UnErase, please visit our website, www.oo-
software.com, and get the latest information about product developments and support. 
Also included on our website are regularly updated FAQs and Knowledge Bases that offer 
the most common problems and questions regarding our products.

All registered customers receive installation and product support free of charge for the fi rst 
90 days after registration. When contacting our support department, please do not forget 
to have your registration code ready. 

In addition, it may be helpful to read our frequently asked questions (FAQ) section of our 
website before you contact our support department. It is always possible that your specifi c 
question or problem may have already been addressed.

 Authorized Distributors

For answers to all questions regarding the licensing and purchase of our software products, 
our authorized distribution partners in over 30 countries stand ready to assist you. Their 
names and addresses may be found at our website under the Purchase heading. We would 
also be more than happy to assist you in fi nding the partner closest to you. 

O&O Software GmbH
Am Borsigturm 48
13507 Berlin
Germany

Tel   +49 (0)30 4303 4303
Fax   +49 (0)30 4303 4399

E-mail   info@oo-software.com
   sales@oo-software.com
Web   www.oo-software.com
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IMPORTANT – PLEASE READ CAREFULLY

This end user license agreement is a legally binding contract between yourself (as a natural 
or a legal person) and the company O&O Software GmbH (O&O) for the software product 
named above. By installing the software product, you declare your agreement with all con-
ditions of the license agreement.

If you do not agree with the conditions of the license agreement, you are not entitled to 
install or use the software product. Should this be the case, you can return the software 
product along with a copy of the invoice or receipt to the distributor from whom the product 
was purchased in exchange for a full refund. 

The software product is protected by copyright laws and international copyright contracts 
as well as other laws and agreements concerning intellectual property. 

1. Subject of the contract
The subject of this contract is the computer program, the description thereof and the user 
manual as well as any other accompanying written material. This will henceforth also be 
referred to as “software”. 

O&O wishes to point out that, at the current state of technology, it is not possible to create 
software that works perfectly in all applications and combinations. The subject of this con-
tract is therefore a software program that is fi t for the purposes detailed in the description 
and the user manual. 

2. License granting 
For the duration of this contract, O&O grants you the simple, non-exclusive and personal 
right (henceforth referred to as “license”) to use a copy of the software on a single com-
puter. If this single computer has multiple users, this user right applies to all users of the 
system.

As a license-holder, you may physically transfer the software (i.e. saved on a data carrying 
medium), on condition that it not be used on more than one computer at a time. Further use, 
especially repeated installation, use, and subsequent deinstallation on various computers 
(fl oating license) is prohibited. 

Test license
You are entitled to test the software free of charge and without obligation according to the 
terms stated within the software (30 day trial period or unlimited read-only trial). If you wish 
to continue using the software, you must purchase the relevant license. 

 End-User License Agreement
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3. Description of further rights and limits 
The license-holder is prohibited from;
(a) altering, translating, reverse-developing, decompiling or disassembling the software 
 without the advance written permission of O&O 
(b) creating products derived from the software or making copies of the written material, 
 translating or altering the written material or creating products derived from the written 
 material
(c) distributing copies of the software to third parties
(d) changing or removing the copyright mark on the copies of the software 
(e) renting out, - or lending the software 

The license holder is permitted to transfer all rights from this license agreement perma-
nently to another person, provided that the recipient also agrees to all conditions of this 
license. 

The license holder must use the software only in compliance with all relevant laws. 

4. Ownership of rights
Any ownership rights applying to the software, including but not limited to copyright laws, 
belong to O&O. Any not explicitly claimed rights are reserved by O&O.

The purchase of a license for a product simply grants a right to use the software as described 
in the conditions of the license agreement. This does not imply a right to the software itself. 
In particular, O&O reserves all publication, multiplication, processing and utilization rights 
to the software. 

5. Reproduction
The software and accompanying written material are protected by copyright laws. The user 
has the right to create copies of the software for back-up and archiving purposes. He or she 
is thereby also obliged to reproduce O&O’s copyright mark on the physical medium or in 
the program. A copyright mark present in the software may not be removed. Copying or 
reproducing the software in original or altered form, or merged with or included in other 
software, is explicitly forbidden. 

Provided you pass on only the test version, you may reproduce the installation data as often 
as you wish. However, you may only pass on exact copies and may not alter these in any 
way. 

For such reproduction, you may not demand any kind of compensation. You may not distrib-
ute or market this product in combination with other products - whether commercially or 
non-commercially - without the advance written permission of O&O.

6. Length of the agreement
This agreement is valid indefi nitely. The right of a license-holder to use this software is re-
moved automatically and without notice if he or she violates one of the terms of this agree-
ment. At the end of the period of right to use, the license-holder is obliged to destroy the 
software, all copies of the software, and the written material. 
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7. Compensation for breach of contract
O&O would like to point out that you are responsible for any damages arising from breach 
of copyright if you violate these contract terms.

8. Changes and Updates
O&O is entitled to update the software as it wishes. O&O is not obliged to make updated 
versions available to license holders who have not registered their product with O&O, or 
who have not paid the update fee. Any additional software code that is made available to 
you as an update is considered a part of the software and is therefore subject to the terms 
of this agreement. 

9. O&O’s Guarantees and Responsibility 
(a) O&O guarantees the original license-holder that the data medium carrying the software 
 is free of errors at the point of delivery, assuming normal operating conditions and a 
 normal level of maintenance. 
(b) If the delivered data carrier is faulty, the purchaser can demand a replacement during 
 the 24-month guarantee period. For this, he or she must return the data carrier, any 
 back-up copies and the written material along with a copy of the invoice or receipt to 
 O&O or to the dealer where the product was purchased.
(c) If a fault as described in clause 9 b is not corrected by means of a replacement delivery 
 within a reasonable time period, the purchaser can demand either that the sale price be 
 reduced or that the contract be cancelled.
(d) For these reasons and for those mentioned in clause 1 of this contract, O&O accepts no 
 responsibility for mistakes in the software. In particular, O&O does not guarantee that 
 the software will meet the particular requirements and demands of the purchaser or that 
 it will function together with other software he or she has chosen. The purchaser is 
 responsible for the correct choice of software and the consequences of the use of that 
 software, as well as the results aimed at or intended. The same principle applies to the 
 written material that accompanies the software. If the software is fundamentally unfi t for 
 use as described in clause 1, the customer has the right to cancel the contract. O&O has 
 the same right should the creation of software that is fundamentally fi t for use as descri-
 bed in clause 1 not be practically possible. 
(e) O&O is not responsible for any damages, unless such damages are caused deliberately 
 or arise from gross negligence on the part of O&O. In contracts with traders, an assump-
 tion of responsibility for gross negligence is excluded. This does not apply to assurances 
 by O&O that refer to specifi c characteristics. Responsibility for damages not included in suc
 h an assurance will not be accepted. 

10. Competency
If the license-holder is a registered merchant under German law, the law that applies to this 
contract is the law of the Federal Republic of Germany. In this case, the state and federal 
courts of the Federal Republic of Germany assume responsibility. 
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If you have any questions regarding the licensing of O&O software or you wish to contact 
O&O, please get in touch with us as follows:

O&O Software GmbH
Am Borsigturm 48
13507 Berlin
Germany

Tel   +49 (0)30 4303 4303
Fax   +49 (0)30 4303 4399

E-mail   info@oo-software.com
   sales@oo-software.com
Web   www.oo-software.com
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